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Introduction

The purpose of this tutorial is to outline the steps of Conjunctive Analysis for use with Risk Terrain Modeling
(RTM; www riskterrainmodeling.com). Technically speaking, Conjunctive Analysis is a method for
multivariate analysis of discrete categorical datal. For crime analysts or researchers who use risk terrain
modeling, Conjunctive Analysis is an analytic tool that can be used to explore spatial interactions among
environmental risk factors. The end product of a Conjunctive Analysis is a data matrix of behavior settings that
displays every possible combination of risk factors throughout a jurisdiction and the relative frequency of
crime associated with each setting. While RTM can be used to identify and validate environmental risk factors
for crime, Conjunctive Analysis can be used to explore the interrelationships among those risk factors. This is
referred to as a Conjunctive Analysis of Risk Factor Configurations (CARFC).

What you'll need:

* RTMDx Utility (free at www.rtmdx.com)
* ESRI ArcGIS

* SPSS or Stata

Add risk factor geotiffs (from RTMDx Utility, Pro version) to ArcMap.

Open ArcMap. Using the ArcCatalog window (Windows>Catalog), navigate to the RTMDx geotiff output
folder and retrieve the geotiff for each significant risk factor from your risk terrain model.

For example, the Best Model Specification table, below, identifies 9 significant risk factors, their
operationalization, and spatial influence. You will need to select the corresponding geotiff for each significant
risk factor (e.g., ...GPDonly_DrugsCFS_density_236, ...GlendaleOnly_Gas_Stations_All_proximity_236, etc.)
and add it to the map.

"Best" Model Specification

The RTMDx Utiity determined that the best risk terrain model was a Negative Binomial type Il model with 9 risk factors and a BIC score of 3240. The model also includes an intercept term that represents the background rate of events and an intercept term that represents
overdispersion of the event counts

Type Name Operationalization spatial Influence Coefficient Relative Risk Value

Rate GPDonly DrugsCFs Density 236 2.3708 10.7060
Rate GlendaleOnly Gas Stations All Proximity 236 17113 55362
Rate GlendaleOnly AptComplxs Proximity 236 16732 5.3292
Rate GlendaleOnly GangMembrs Proximity 1413 1.3996 4.0536
Rate GlendaleOnly Restaurants TakeOut Proximity 236 1.1938 3.2996
Rate GlendaleOnly ConvenStores Proximity a7 1.1707 3.2242
Rate AZ Ligr Busi ActvStores Density 1413 1.0600 2.8864
Rate GlendaleOnly Banks ATMs Proximity an 0.9764 2.6550
Rate AZ Ligr Busi ActvBars Proximity an 0.9190 2.5067

Rate Intercept - - -5.6880

Overdispersion Intercept = - 0.8938
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You can drag and drop each geotiff from the ArcCatalog window to your Table of Contents in ArcMap (see
below).
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Convert each risk factor geotiff to a raster GRID.

Now each risk factor geotiff must be converted to a raster GRID. Right-click each risk factor geotiff, select
“Data,” and then select “Export Data.” The Export Raster Data dialogue box will appear (see below).

Export Raster Data - output.csv.1258763483.output-ri1p01_Glendale... ﬂ
Extent Spatial Reference
(") Data Frame (Current) )
~ Data Fi C t
(@) Raster Dataset (Original) 2L G
(@) Raster Dataset (Original
Selected Graphics (Clipping) Clip Inside B (Original)
Output Raster
["Juse Renderer [|square: Cell Size (cx, cy): | 235.64451252 235.6445125.
Force RGB Raster Size (columns, rows): () [ 437 329
Use Colormap NoData as:  -9.990000e+0
Name Property
Bands 1
Pixel Depth 32 Bit
Uncompressed Size 561.61 KB
Extent (left, top, right, bottom) (529728.9426, 985814.0043, 632705.5946, 908286.9596 )
Spatial Reference NAD_1983_StatePlane_Arizona_Central_FIPS_0202_Feet_Intl
Location: C:\Users\jbarnum\Desktop\CADemo\GRIDs
Name: Gas_P236 Format: [GRID ']
Compression Type: NON Compression Quality 75
. ONE Y (1-100):
About export raster data
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You'll need to edit the following parameters: Location, Name, and Format. All other parameters should be left

as their default option.

Location is where you’ll save each raster GRID. Select the yellow folder icon and navigate to a desired save
location. In your desired location, create a new folder (e.g., Example City Example Crime Conjunctive
Analysis) to save all data for this conjunctive analysis. Within your newly created Conjunctive Analysis folder,
create another new folder called GRIDs. Click once to select this folder and then select “Add” to choose this
folder to save the current GRID.

Name is what you’ll name each raster GRID. A good name identifies the risk factor name, operationalization,
and influence. Note: raster GRID file names can only contain 13 characters. In the example above, the risk
factor “proximity within 236 feet of Gas Stations” is saved as “Gas_P236.”

For format, select “GRID.”

Finally, click save and add your new raster GRID to the map.

Repeat each step to convert the remaining risk factor geotiffs to raster GRIDs.
Convert each risk factor GRID to a Vector Polygon Shapefile “Grid”.

Now, each risk factor raster GRID must be converted to a Grid of Vector Polygons (henceforth called a “Vector
Grid”).

First, download the RTM toolbox for ArcGIS here: http://www.rutgerscps.org/software.html.
Add the toolbox in your current ArcMap session by right clicking in the ArcToolbox area and selecting “Add

Toolbox.” Note: You may need to use the “Connect To Folder” button to connect to your downloads folder.

Open the “Convert Raster Layer to Vector Grid” tool within the Risk Terrain Tools toolbox. This tool will be
used to convert each risk factor raster GRID to a Vector Grid.

You'll need to edit the following parameters: Raster Layer, Cell Size Width, Cell Size Height, Final Vector Grid,
and TempGrid.
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% Convert Raster Layer To Vector Grid @@é
Raster Layer Convert Raster Layer To Vector
| output.csv.1258763483.output-r11p01_GlendaleOnly_Gas_Stations_All_proximY_ Grid
Cell Size Width (i.e., same as your raster cell size)
236 This tool converts a raster map layer into a
) o ) vector grid of equally-sized polygonal cells and
Cell Size Height (i.e., same as your raster cell size) records the value for each cell (i.e., as the
236 "GRID_CODE" variable). IMPORTANT: In the
Final Vector Grid "Cell Size" text boxes, enter the exact same
C:\Users\jbarnum\Desktop\CADemo\Vector Grids\Gas_P236_VG.shp cell size that exists for the input raster.
TempGrid (intermediate parameter, will be deleted)
C:\Users\jbarnum\Desktop\CADemo\Vector Grids\GP236.shp
oK l [ Cancel ] [ Environments... ] [ << Hide Help ] [ Tool Help
U UU—————

Raster Layer defines which raster GRID you will convert to a Vector Grid. Select any raster GRID (by clicking
the drop-drown menu) to begin.

Cell Size Width and Cell Size Height define the size of the cells in the Vector Grid. You should indicate values
(e.g., 236) that are identical to the Cell Size used in your risk terrain model. Note: you can find the cell size you
used in your risk terrain model under Analysis Input Details in your RTMDx output .html report). Cell Size
and Cell Height should be identical values (and the same across all risk map layers).

Final Vector Grid defines the name and save location of the Vector Grid you will create. First, select the yellow
folder icon and navigate to your Conjunctive Analysis folder. Create a new folder called Vector Grids to save
your current Vector Grids. Now, define the name of your current risk factor Vector Grid. Note: there are no
character restrictions for Vector Grids, though Windows does not permit file and or path names to exceed 164
characters. A good name identifies the risk factor name, operationalization, and influence. This should be
similar to the name you used for the raster GRID (e.g., Gas_P236_VG).

TempGrid is an intermediate parameter (required for processing). Proceed by defining a name and save
location (similar to what you did for the Final Vector Grid parameter). It is good practice to direct the save
location to your Vector Grid folder and use a logical name (e.g., GP236VG), but you cannot use the same name
as you used for Final Vector Grid.

Click Ok. Your new risk factor Vector Grid will be added to the map.

Right-click on the new risk factor Vector Grid and open the attribute table. Delete all columns except FID,
Shape, and GRID_CODE.
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With the attribute table open, select the “Table Options” button and create a new column. Column type should
be “Short Integer” and the column name should reflect the relevant risk factor (e.g., Gas_P236). Note: column
names can only contain 10 characters.

Right-click on new column heading and select “Field Calculator” (see Field Calculate dialogue box below) to
calculate GRID_CODE values to the new column (disregard the warning message). Double click GRID_CODE
under “Fields.” Click ok.

Field Calculator &j

Parser

Q) VB Script ~) Python
Fields: Type: Functions:
FID (@) Number 2?:(( ))
Shape Cos ( )
GRID_CODE () String B ()
Gas_P236 @ Date Fix ()
- Int( )
Log ()
Sin( )
Sar ()
Tan ()

Gas_P236 =
[GRID_CODE]

["] show codeblock E] [:] [E]

About calculating fields [ Clear ] [ Pt ] [ Save... ]

e

Right-click new column heading and select “Sort Descending” to verify the Field Calculator worked as
intended (i.e., look for 1s and 0s).

Right-click the GRID_CODE heading and select delete.

Your Vector Grid table should appear like the image below. Repeat these steps to convert remaining risk factor
GRIDs to Vector Grids.

& Table
= ERAE- AL L3
Gas_P236 VG

FID Shape * Gas_P236
» | 2105 | Polygon
4482 | Polygon
10048 | Polygon
10115 | Polygon
10639 | Polygon
17674 | Polygon
19439 | Polygon
20688 | Polygon
22703 | Polygon
22724 | Polygon

"o 1 » »|[E®= (0outof 31107 Selected)
Gas_P236_VG

&

g |
“

N K KT K R RS
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Spatially Join all Vector Grids.

Now, all risk factor Vector Grids must be spatially joined. Within ArcToolbox, navigate to “Analysis Tools,”
select “Overlay,” and then select “Spatial Join.” The Spatial Join dialogue box will appear (see below).

“ Spatial Join SHIE X

Target Features Output Feature Class
| Gas_P236_vG

Join Features
[ Apt_p236_vG
Output Feature Class
C:\Users\jbarnum\Desktop\CADemo\Vector Grids\VG236_Gas_Apt.shp

|«

|«

A new feature class containing the attributes of
the target and join features. By default, all
attributes of target features and the attributes
of the joined features are written to the output.
However, the set of aftributes to be transferred
can be controlled by the field map parameter.

Join Operation (optional)
JOIN_ONE_TO_ONE

4

v|Keep All Target Features (optional)

Field Map of Join Features (optional)

(- Gas_P236 (Short)
- G_P236 (Short)

CIREINFIRET

Match Option (optional)
INTERSECT v| ¥ v

oK ] [ Cancel ] [ Environments... ] [ << Hide Help ] [ Tool Help

You'll need to edit the following parameters: Target Features, Join Features, Output Feature Class. All other
parameters should be left as their default option.

Target Features refer to the risk factor Vector Grid that you intend to join to and Join Features refers to the risk
factor Vector Grid that is being joined. In the image above, the Apartments Vector Grid is being joined to the
Gas Stations Vector Grid. Note: For the first join, any two risk factor Vector Grids may be selected for the
Target Features and Join Features, respectively. For subsequent joins, the most recently created Vector Grid
created via the Spatial Join tool should be used as Target Features and a remaining unjoined risk factor Vector
Grid should be used as Join Features. This step is repeated until all risk factor Vector Grids are joined into a
single Vector Grid.

Output Feature Class defines the file name and save location. First, select the yellow folder and navigate to
your Conjunctive Analysis folder. Create a new folder called Joins and save all new joins in this folder. Define
a name for your current join. It is good practice to begin the name with VG (i.e., Vector Grid) and the cell size
(e.g., 236). Next, include the abbreviations for the risk factor Vector Grids that have been joined, and those that
are going to be joined in the current process. In the image above, Gas and Apt are the first two risk factors
Vector Grids to be joined and are indicated in the name (e.g., VG236_Gas_Apt). For each subsequent join,
continue to build upon the previous file name (e.g., in this example, the next join will be
VG236_Gas_Apt_Gang).
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Click ok. This spatially joins the Gas Stations and Apartments Vector Grids and creates a new Vector Grid with
the Gas and Apt columns in the attribute table. Recall: this Vector Grid will be used at the Target Features to
join the next risk factor Vector Grid, and so on.

Repeat these steps until you have created a single Vector Grid by spatially joining together all individual risk
factor Vector Grids. Once finished, open the attribute table and delete all columns except FID, Shape, and each
risk factor column.

Join priority crime counts to risk factor Vector Grid.

Now, crime counts must be joined to your complete risk factor Vector Grid. First, select “Add Data.” Locate
the priority crime shapefile (i.e., the outcome event in your risk terrain model) and add to ArcMap.

Right-click the risk factor Vector Grid, select “Joins and Relates,” and then select “Join.” Be sure to “Join data
from another layer based on spatial location.”

Join Data lé‘

Join lets you append additional data to this layer's attribute table so you can,
for example, symbolize the layer's features using this data.

What do you want to join to this layer?

[Join data from another layer based on spatial location ']

1. Choose the layer to join to this layer, or load spatial data from disk:

[® Robbery_2012 ~

2. You are joining:  Points to Polygons

Select a join feature class above. You will be given different
options based on geometry types of the source feature class
and the join feature class.

@) Each polygon will be given a summary of the numeric attributes of
points thatfall inside it. and a countfield showing how many points
inside it

How do you want the attributes to be summarized?
["]Average [ Minimum [ Standard Deviation
["]sum | Maximum ["]variance

~) Each polygon will be given all the atfributes ofthe point thatis clos
its boundary. and a distance field showing how close the pointis (i
units of the target layer).

Note: A pointfalling inside a polygon is treated as being closestt
polygon, (i.e. a distance of 0).

3. The result of the join will be saved into a new layer.
Specify output shapefile or feature class for this new layer:

C:\Users\jbarnum\Desktop\CADemo\Joins\VG213_Risk_

About joining data [ oK ] [ Cancel

You'll need to edit the 1%t and 3¢ parameters in the Join Data dialogue box. All other parameters should be left
as their default option.

For “Choose the layer to join to this layer...” Select your priority crime.
For “Specify output shapefile or feature classes...” Define a name and save location. Select the yellow folder

and navigate to your Joins folder. Define a name. Since this is the final join you'll make, a good name at this
point is VGCellSize_Risk_Crime. Use your cell size and crime type in the name.

Click OK.
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After the Risk Factor and Crime Vector Grid is added to the map, open the attribute table and create a new
column. Column type should be “Long Integer” and the column name should reflect the priority crime.
Once the new column is created, right-click the heading and select “Field Calculator” to calculate “Count_"
values to the newly created crime column. Double-click “Count_” under “Fields.” Click OK.

Field Calculator &J
Parser
Q) VB Script () Python
Fields: Type: Functions:
Apt i Q@) Number Abs ()
Gang Atn ()
RestTO ) string Cos( )
- Bxp ()

Conv Date Fix ()
LiqStr ) Int( )
ATMs Log ()

E Sin( )
Bars Sqr( )
Crime Tan ()
Count_

Crime =

[ show Codeblock E] B E]

[Count_]

About calculating fields [ Clear ] l Load... ‘ I Save... ’

Right-click the new column and select “Sort Descending” to verify the Field Calculator worked as intended
(i.e., rows should match Count_).

Delete the Count_ field.

Export final Vector Grid to .dbf.

At this point, you have created a Vector Grid with columns of 1s or 0s to indicate presence or absence of each
risk factor’s spatial influence at every cell throughout the study area, and a column of integer values to

indicate the number of priority crimes in each cell throughout the study area (e.g., see below). This table will
be exported from ArcMap to execute a Conjunctive Analysis in your statistical software (i.e., SPSS or SAS).
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Table
SRR RS X
VG236_Crime_Risk

%o h B E

FID | Shape | Drugs | Gas | Apt | Gang | RestTO | Conv LiqStr ATMs | Bars | Crime

o 18 | Polygon 0 0 0 0 0 0 1 0 0 0

- 19 | Polygon 0 0 0 0 0 0 1 0 0 0

20 | Polygon 0 0 0 0 0 0 1 0 0 0

0 21 | Polygon 0 0 0 0 0 0 1 0 0 0

& 22 | Polygon 0 0 0 0 0 0 0 0 0 0

23 | Polygon 0 0 0 0 0 0 0 0 0 0

E 24 | Polygon 0 0 0 0 0 0 0 0 0 0

= 25 | Polygon 0 0 0 0 0 0 0 0 0 0

26 | Polygon 0 0 0 0 0 0 0 0 0 0

27 | Polygon 0 0 0 0 0 0 0 0 0 0

28 | Polygon 0 0 0 0 0 0 0 0 0 0

e 29 | Polygon 0 0 0 0 0 0 0 0 0 0

X 30 | Polygon 0 0 0 0 1 0 0 0 0 0

= 31| Polygon 0 0 0 0 0 0 0 0 0 0

32 | Polygon 0 0 0 0 0 0 0 0 0 0

33 | Polygon 0 0 0 0 0 0 0 0 0 0

b - 34 | Polygon 0 0 0 0 0 0 0 0 0 0

35 | Polygon 0 0 0 0 1 0 0 0 0 0

n 36 | Polygon 0 0 0 0 0 0 1 0 0 0

37 | Polygon 0 0 0 0 0 0 1 0 0 0

38 | Polygon 0 0 0 0 0 0 1 0 0 0

39 | Polygon 0 0 0 0 1 0 1 1 0 0

[ 40 | Polygon 0 0 0 0 0 0 1 1 0 0

B 41 | Polygon 0 0 0 0 0 0 1 1 0 0

42 | Polygon 0 0 0 0 0 0 1 0 0 0

43 | Polygon 0 0 0 0 0 0 0 0 0 0

= 44 | Polygon 0 0 0 0 0 0 0 0 0 0
3""”] L 1 » » [E|= (0 out of 31037 Selected)

VG236_Crime_Risk |

First, within the attribute table, be sure all columns are deleted except, FID, Shape, Risk Factors, and Crime
(see above).

Next, select “Table Options,” and then select “Export.”

Third, navigate to your Conjunctive Analysis folder. Define your save name as VG236_Risk_Crime (using your
cell size and crime type). Then, define “Save as type” as dBASE Table. Click Save. This layer does not need to
be added to the map.

Finally, save your ArcMap .mxd file within your Conjunctive Analysis folder and close ArcMap.

Execute the Conjunctive Analysis.

Now it’s time to do the Conjunctive Analysis using the Risk Factor and Crime dBASE Table. First, open SPSSi.

Now, open your dBASE Table (File>Open). Once opened, save your dBASE Table as a .sav (SPSS) file
(File>Save As). You will run the Conjunctive Analysis on the SPSS file.
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Open a new Syntax (File>New>Syntax). Copy and paste the following code into the Syntax:
SORT CASES BY varl var2 var3...etc. (D).

AGGREGATE /OUTFILE=/PATH NAME GOES HERE/FILE_NAME_GOES_HERE.sav'
/BREAK=varl var2 var3...etc

/Crime_N=SUM(Crime)

/N_BREAK=N.

The bolded text within each command line needs to be edited to reflect your data.

var 1, var2, var3... should be changed to the column names used in your dBASE Table. Use only a space
between each variable name and do not include the crime column in this command line. The list of variables
can be copied and pasted to follow the “/Break=" command, but do not include “(D)” at the end. For example,

SORT CASES BY Gas_P236 Apt_P236 Bus_D472 (D).
/BREAK= Gas_P236 Apt_P236 Bus_D472

PATH NAME... should reflect the file path that leads to the folder where you prefer your conjunctive analysis
data matrix to be saved. For example,

/OUTFILE=/Users/jbarnum/Desktop/ConjunctiveAnalysis
FILE NAME... defines the conjunctive analysis matrix that you will create. For example,
/OUTFILE="/Users/jbarnum/Desktop/ConjunctiveAnalysis/City_Crime_DataMatrix.sav’

Crime... should reflect your priority crime (i.e., from your risk terrain model). Be sure it is defined in the exact
same way that you defined your priority crime column. For example,

/Crime_N=SUM(Crime)
Before proceeding, check for errors/typos.

Now, highlight the syntax and click run by clicking the green arrow (see below). Note: this process creates a
new SPSS file (separate from the currently open data file) — the Conjunctive Analysis Data Matrix. If the
process fails to complete, check the Output file for any errors. If errors exist, double-check your Syntax for
errors and then re-run.

@ SPSS Statistics File Edit View Data Transform Analyze Direct Marketing Graphs Utilities Add-ons Run Tools Window Help 100% @@ «)) Thu2:18 PM jerbarnum Q =
[ XX ) Syntax2 - IBM SPSS Statistics Syntax Editor

=1 1= o BEREE N PO 0 a RS
0 “ :Runsele(uon’atasetl |

=
D |SORT CASES BY Gas_P236 Apt_P236 Bus_D47 (D).

SORT CASES

AAGGREGATE /OUTFILE="/Users/jbarnum/Desktop/Conjuncti is /City_Crime_|

/BREAK=Gas_P236 Apt_P236 Bus_D472
/Crime_N=SUM(Robbery)
/N_BREAK=N.

Nouawne
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You can find the newly created Conjunctive Analysis Data Matrix in the folder, and with the file name, that
you’'ve indicated in the syntax via Path Name and File Name. Now, open your Conjunctive Analysis Data
Matrix in SPSS. Again, if your file doesn’t exist, your syntax may contain errors. Check your Output file for
errors and then check your Syntax.

& SPSSsStatistics File Edit View Data Transform Analyze Direct Marketing Graphs Utilities Add-ons Window Help $3 YO % = 100%@@ «)) Thu2:19PM jerbarnum Q i=
(X X ] (@ GPD_CAMatrix.sav [DataSet1] - IBM SPSS Statistics Data Editor

SHE Lsf e M BouHE .9

| Visible: 11 of 11 Variables

Drugs Gas Apt Gang RestTO Conv. Ligstr ATMs Bars Crime N_BREAK
23.00 15375
00 128
.00 36
22.00 952
.00 46
.00 27
.00 10
3.00 8
.00 22
.00 8
4.00 11

2.00 6

o o o o o o o o o o o o o
o o o o o o o o o o o o o
o o o o o o o o o o o o o
o o o o o o o o o o o o o
~ o o o o o o o o o o o o
o r r n n o o o o o o o
o nr n no rm nkn o o o
o nr o o o r no o n oo
o r o r o kr o r oo n o

.00 11

Save your Conjunctive Analysis Data Matrix as an .xIs file (File>Save As). Because they are different file
extensions, you can use the same name as the SPSS file (e.g., City_Crime_DataMatrix).

Finally, be sure to save your Syntax and Output files in your Conjunctive Analysis folder.
Prepare the Conjunctive Analysis output for reporting.

As previously described, the conjunctive analysis produces a data matrix displaying every combination of risk
factors throughout the study area. The number of possible combinations is determined by the number of risk
factors and categories within them (here, the number of categories is two: 1 indicates presence of risk factor’s
spatial influence and 0 indicates absence of influence). For example, 9 risk factors have the potential to create
512 combinations (e.g., 2°=512). Each combination can be considered a “behavior setting.” The conjunctive
analysis will also identify the number of times each particular behavior setting appears in the study setting
(n_break) and the number of crimes each behavior setting is responsible for.

The data matrix of behavior settings can be quite large, thus it is important to prepare the information
produced by the conjunctive analysis so that it can be meaningfully reported. This can be done using Microsoft
Excel. Typically, you'll want to focus on dominant behavior settings and the most criminogenic behavior
settings.

First, open your conjunctive analysis data matrix .xls file in Microsoft Excel. Before proceeding, verify that the
number of rows does not exceed the number of possible behavior settings. If the number of rows exceeds the
number of possible behavior settings, verify that you've opened the correct file (i.e., the data matrix you
created and NOT the .sav file you used to create the data matrix).

Focus on “Dominant” Behavior Settings
Dominant behavior settings appear in the study setting at 10 times or more (i.e., have a n_break value of 10 or

higher). To remove non-dominant behavior settings, sort the n_break column descending (i.e., largest to
smallest). Select all rows with a value of 9 or less, right-click, and select delete.
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Focus on “Criminogenic” Behavior Settings

“Criminogenic” behavior settings can be defined in a number of ways. One way is by the raw total number of
crimes that occur in behavior settings. The “Crime” column that was created in the conjunctive analysis
denotes this.

The percentage of crime behavior settings contained is another way to gauge how criminogenic they are. To
calculate this, create a new column with the name “Percent Crime.” In the first row under Percent Crime, use
an Excel formula to divide the number of crimes in that behavior setting by the number of overall crimes, and
then multiply that value by 100.

In the example below, “J2” identifies the number of crimes in the behavior setting and “629” is the number of
overall crimes in the study setting during the study period (the latter should be the same number of events
tested in your risk terrain model; see your RTMDx Output). Apply this formula to the remaining rows (you
can do this by positioning your mouse over the lower right-hand corner of the cell until a “plus” appears, then
double-clicking).

STDEV - ® " | =(12/629)*100

A B C D E F G H | J K L M N
1 Drugs Gas Apt Gang ResfTO  Conv LigStr ATMs Bars Crime N_BREAK Percent Crime
2 0 0 0 0 0 0 0 0 o[ 23] 15375[=(J2/629)"100]
3 0 0 0 1 0 0 0 0 0 179 11253
4 0 0 0 1 0 0 1 0 0 167 2257
5 0 0 0 0 0 0 1 0 0 22 952
6 0 0 0 0 0 0 0 0 1 0 128
7 0 0 0 1 0 0 1 0 1 17 127
8 0 0 0 1 0 0 0 0 1 12 99
9 0 0 1 1 0 0 0 0 0 0 76

Crime and Percent Crime do not account for the total area each behavior setting represents in the study
setting. For example, some behavior settings have a higher n_break value, which indicates a larger area (and
necessarily, more crimes). A rate can be calculated — referred to here as the Relative Frequency of Crime — to
control for this issue.
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Create a new column with the name “Relative Frequency of Crime” (RFC) to calculate the number of crimes as
a function of the number of times a behavior setting appears. In the example below, “]J2” identifies the number
of crimes in the behavior setting and “K2” identifies the number of times that behavior setting appears in the
study setting. Apply this formula to the remaining rows. Sort the RFC column descending to identify the most
criminogenic behavior settings.

STDEV - ® « £ =(2/K2)*100
A B C D E F G H | J K L M N

1 Drugs Gas Apt Gang RestfTO  Conv LigStr ATMs Bars Crime N_BREAK Percent Crime Relative Frequency of Crime
2 0 0 0 0 0 0 0 0 o[ 23] 15375] 3.656597774[=(J2/K2)"100

3 0 0 0 1 0 0 0 0 0 179 11253  28.45786963

4 0 0 0 1 0 0 1 0 0 167 2257 26.55007949

5 0 0 0 0 0 0 1 0 0 22 952 3.497615262

6 0 0 0 0 0 0 0 0 1 0 128 0

7 0 0 0 1 0 0 1 0 1 17 127 2.702702703

8 0 0 0 1 0 0 0 0 1 12 99 1.907790143

9 0 0 1 1 0 0 0 0 0 0 76 0

At this point, the conjunctive analysis data matrix contains all dominant behavior settings. Because this
number may still be quite large, it may be necessary to further reduce the number of behavior settings to allow
for better prioritization of risky places. This can be done by eliminating behavior settings that do not meet a
certain threshold based on the RFC. For example, you may calculate the mean RFC, and eliminate behavior
settings that have a RFC below the meanii. More stringently, you may choose to eliminate behavior settings
below one standard deviation above the mean RFC, or below two standard deviations above the mean RFC.
Note: The number of behavior settings to display, and the thresholds used to make those determinations, are
inherently subjective and will vary depending on the particular characteristics of the problem and jurisdiction.

Calculate the mean RFC
STDEV v (* X & fc| =AVERAGE(M2:M30)
A B C D E F G H 1 J K L M N [0} P

1 Drugs Gas Apt Gang RestTO  Conv LigStr ATMs Bars Crime N_BREAK Percent Crime Relative Frequency of Crime

2 0 0 0 0 0 0 0 0 0 23 15375 3.656597774 0.149593496

3 0 0 0 1 0 0 0 0 0 179 11253 28.45786963 1.590686928 =AVERAGE(M2:M30) 1
4 0 0 0 1 0 0 1 0 0 167 2257 26.55007949 7.399202481

5 0 0 0 0 0 0 1 0 0 22 952 3.497615262 2.31092437

6 0 0 0 0 0 0 0 0 1 0 128 0 0

7 0 0 0 1 0 0 1 0 1 17 127 2.702702703 13.38582677

8 0 0 0 1 0 0 0 0 1 12 99 1.907790143 12.12121212

9 0 0 1 1 0 0 0 0 0 0 76 0 0

10 1 0 0 1 0 0 1 0 0 20 74 3.179650238 27.02702703

1 0 0 0 1 0 0 1 1 0 " 73 1.748807631 15.06849315
Calculate the standard deviation of the RFC

STDEV v (X & fc| =STDEV(M2:M30)
A B © D E F G H I J K L M N o P

1 Drugs Gas Apt Gang RestTO  Conv LigStr ATMs Bars Crime N_BREAK Percent Crime Relative Frequency of Crime

2 0 0 0 0 0 0 0 0 0 23 15375 3.656597774 0.149593496

3 0 0 0 1 0 0 0 0 0 179 11253 28.45786963 1.590686928 15.00841446
4 0 0 0 1 0 0 1 0 0 167 2257 26 55007949 7.399202481

5 0 0 0 0 0 0 1 0 0 22 952 3.497615262 2.31092437

6 0 0 0 0 0 0 0 0 1 0 128 0 0

7 0 0 0 1 0 0 1 0 1 17 127  2.702702703 13.38582677

8 0 0 0 1 0 0 0 0 1 12 99 1.907790143 12.12121212

9 0 0 1 1 0 0 0 0 0 0 76 0 0

10 1 0 0 1 0 0 1 0 0 20 74 3.179650238 27.02702703

11 0 0 0 1 0 0 1 1 0 1" 73 1.748807631 15.06849315

To calculate one standard deviation above the mean, simply add the standard deviation value to the mean. To
calculate two deviations above the mean, simply add the standard deviation value to the value calculated by
adding the mean and one standard deviation value. In other words, add the standard deviation value to the
mean twice. Eliminate rows below desired threshold.
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At this point, you can select all remaining rows and columns in your data matrix and copy and paste into
Microsoft Word to prepare for reporting.

Communicate meaningful information.

It is easiest to prepare your data matrix in a blank Microsoft Word document using narrow margins and a
landscape orientation. Once that table is finished, it should fit within a standard 8.5x11 layout with 1-inch
margins.

First, insert a new column to the very left side of the data matrix. Name this column “Behavior Setting” and
then number the rows consecutively.

Table Tools

Layout

= el flveo ot 2 Bfosubuerows SIS A
= e

=2=5= —
Select | View |Properties Delete | Insert Insert Merge  Split ~ Split ~ AutoFit | == Width: 0.69" Text Cell
v (Gridlines Above Below Left Cells  Cells  Table d A

Tﬂ Distribute Columns
E E E Direction Margins

Table Cell Size Alignment

Next, select the “Design” tab and choose a theme.

Table Tools

@ Header Row @ First Column
Total Row Last Column > Borders ™y, pt -
Draw  Eraser
[#] Banded Rows Banded Columns 4"5" Color ™ Table
Table Style Options Draw Borders
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Now, select the “Behavior Setting” and risk factor column headings. Under the “Layout” tab, re-orient the text
direction (see below).

Table Tools

Layout

Page Layout  References Mailings  Review

Al Y10 - A A A UL A
&~ B~

Clipboard 5] Paragraph = Styles
& - - f=[ - [=[ - [=f - -[[ - =] -3[=f - [=][ 4[]+ [=[-5 [&f - [ - - - [&] -7 - - [&] 8- - ' [&

AaBbCcDdEe | AaBbCcDdEe  AaBhCcDd AaBbCc

1 Normal fNo Spacing  Heading 1 Headin¢

" Crime NBREA " Percent
Cr|me

1.271860095 | 57.14285714

3.179650238 | 27.02702703 |

Rename the column headings. It is also a good idea to appropriately align the columns. Column headings
should be bottom centered, and row information should be center centered. Finally, remove all but two
decimal places for values under Percent Crime and RFC.

o -

Fil

AaBbCcDdEe

AaBbCcDdEe  AaBhCcDd AaBbCcDdI AaBbt

Paste : : : s
1 Normal 1 No Spacin Heading 1 Heading 2 Title
+ ¥ Format Painter pacing 9 9
Clipboard = Styles
1 1 1 2 3 I 4 [ + 5 1 6 1 7 8 - Al 9 !

B s
i i 3 [ - A i ; ; ; i
i i s £ i i i i i i | i
- | E 5 3 § | 1 1 1
' - s 5 &8 e 5 i i i i i
& 5 g s 2 < & 5 i | | i |
s 22 s 5 5 g =2 i ! ! ! i i
2 & B E & 3 5 | | | | Relative |
[T TR -7 - T - - A R | i i 1
oz 5 & & & 2 &8 = 5 5 Percent | Frequencyof |
e o i © | | | = - < | Crime | Cell Cmmt Crime | Crime |

~
o
o
o
-
=)
-
-
o
o

56 | 69 I 8.90 | 81.16

8 14 1.27 57.14

N
°
°
°
N
°
-
-
°
-

74 3.20 27.03

o
-
°
°
-
o
°
N
°
°
N8

As a final step, adjust the column sizes. Attempt to make the table small enough for a standard 8.5x11 inch
sheet of paper with 1-inch margins.
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Interpret the Conjunctive Analysis Data Matrix.

The final data matrix below displays 7 dominant behavior settings with a RFC greater than the mean for
calendar year 2012 crime incidents in a major city in the United States. Together, these behavior settings
constitute less than 1% of the study area, but are responsible for 19% of the crimes.

Table 1: Conjunctive Analysis Data Matrix of Behavior Settings for Calendar Year 2012 Incidents
of Crime in City, STATE

o "

3 g 3

= 55
g E $ F 2
g s 6 5 % 8 3
e 7] c - £ (3 c 5
5 & £ s § 8 £ &
2 2= B g & 8 § ¢ Relative
g » 2 F ¥ e z 3 @
c F & & 5 £ 5 % E & Percent  Frequency
@ Q U «£ U F O T « o Crime Cell Count Crime of Crime
1 1 0 0 1 0 1 1 0 0 9 11 1.43 81.82
2 0 0 0 1 0 1 1 0 0 56 69 8.90 81.16
3 0 0 0 1 0 0 1 1 1 12 19 1.91 63.16
4 0 0 0 1 0 1 1 0 1 8 14 1.27 57.14
5 0 0 0 0 0 1 1 1 0 11 0.64 36.36
6 1 0 0 1 0 0 1 0 0 20 74 3.20 27.03
7 0 0 0 1 0 0 1 1 0 11 73 1.75 15.07

The risk terrain model suggests that that confluence of weighted risk factors at particular locations creates high
risk for crime. The conjunctive analysis suggests that the spatial interaction of risk factors creates risky locations
for crime.

The most problematic behavior setting is characterized by the spatial interaction of drug markets, gang
territories, convenience stores, and liquor stores. This behavior setting has the highest RFC of 81.82 and
appears 11 times in the study settings. It contains 9 crimes, or 1.43% of all crimes in the study setting during
the study period.

The data matrix also shows that gang territories and liquor stores appear frequently in the most problematic
behavior settings, suggesting that these factors consistently aggravate the risk posed by other factors in the risk

terrain model.

Endnotes

i Miethe, Hart, and Regoeczci (2008) The Conjunctive Analysis of Case Configurations: An Exploratory Method for
Discrete Multivariate Analyses of Crime Data, Journal of Quantitative Criminology, 24, 227-241.

it Conjunctive Analysis can also be completed in STATA and SAS. The syntax code for these programs is provided by
Miethe, Hart, and Regoeczci (2008).

it A method used in one jurisdiction was to calculate the mean RFC of behavior settings that include 10 or more cells (i.e.,
dominant behavior settings), but then select any behavior setting from the entire matrix that has a RFC greater than the
mean, even if the N is less than 10 cells.

For examples of CARFC applied to real-world research and practice, see
http://www.rutgerscps.org/publications.html > scroll down to Conjunctive Analysis
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